
 

DIGITAL 

CONTROL 

INCORPORATED 
dci@digital-control.com 

www.DigiTrak.com 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

Log-While-Drilling DataLog ®

 System 
 

Operator’s Manual 
 

mailto:dci@digital-control.com
http://www.digitrak.com/


 DIGITAL CONTROL INCORPORATED   

2 DigiTrak
®
 LWD™ DataLog

®
 Operator’s Manual 

403-3300-00-B3, Dec 2013 

© 2010–2013 by Digital Control Incorporated. All rights reserved. 

Trademarks 

The DCI logo, CableLink
®
, DataLog

®
, DigiTrak

®
, Eclipse

®
, F2

®
, F5

®
, iGPS

®
, MFD

®
,
 
SST

®
, target-in-the-

box
®
, Target Steering

®
, and TensiTrak

®
 are U.S. registered trademarks and DucTrak™, FBC™, FBP™, 

F Series™, FSD™, FasTrak™, LWD™, SBP™, SE™, SED™, SuperCell™, and TeleLock™ are 
trademarks of Digital Control Incorporated. 

Limited Warranty 

All products manufactured and sold by Digital Control Incorporated (DCI) are subject to the terms of a 
Limited Warranty. A copy of the Limited Warranty is included at the end of this manual; it can also be 
obtained by contacting DCI Customer Service, 425-251-0559 or 800-288-3610, or at DCI's website, 
www.digitrak.com. 

Important Notice 

All statements, technical information, and recommendations related to the products of DCI are based on 
information believed to be reliable, but the accuracy or completeness thereof is not warranted. Before 
utilizing any DCI product, the user should determine the suitability of the product for its intended use. All 
statements herein refer to DCI products as delivered by DCI and do not apply to any user customizations 
not authorized by DCI nor to any third-party products. Nothing herein shall constitute any warranty by DCI 
nor will anything herein be deemed to modify the terms of DCI’s existing Limited Warranty applicable to all 
DCI products. The most recent version of this manual is available on DCI's website. 

Compliance Statement 

This equipment complies with Part 15 of the Rules of the FCC and with Industry Canada license-exempt 
RSS standards and with Australia Class License 2000 for LIPD (low interference potential devices). 
Operation is subject to the following two conditions: (1) this equipment may not cause harmful 
interference, and (2) this equipment must accept any interference received, including interference that 
may cause undesired operation. DCI is responsible for FCC compliance in the United States: Digital 
Control Incorporated, 19625 62nd Ave S, Suite B103, Kent WA 98032; phone 425-251-0559 or 800-288-
3610. 

Changes or modifications to any DCI equipment not expressly approved and carried out by DCI will void 
the user’s Limited Warranty and the FCC’s authorization to operate the equipment. 

CE Requirements 

  DigiTrak receivers are classified as Class 2 radio equipment per the R&TTE Directive and 
may not be legal to operate or require a user license to operate in some countries. The list of restrictions 
and the required declarations of conformity are available on DCI’s website, www.digitrak.com, under the 
Service & Support tab. Click on DOWNLOADS and select from the CE Documents pull-down menu to 
download, view, or print the documents. 

http://www.digitrak.com/
http://www.digitrak.com/customerservice/downloads.html
http://www.digitrak.com/customerservice/downloads.html
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Contact Us 

United States 

DCI Headquarters 

19625 62nd Ave S, Suite B103 

Kent, Washington 98032, USA 

+1.425.251.0559 / 1.800.288.3610 

+1.425.251.0702 fax 

dci@digital-control.com 

Australia 2/9 Frinton Street 

Southport QLD 4215 

+61.7.5531.4283 

+61.7.5531.2617 fax 

dci.australia@digital-control.com 

China 368 Xingle Road 

Huacao Town 

Minhang District 

Shanghai 201107, P.R.C. 

+86.21.6432.5186 

+86.21.6432.5187 fax 

dci.china@digital-control.com 

Europe Brueckenstraße 2 

97828 Marktheidenfeld 

Germany 

+49.9391.810.6100 

+49.9391.810.6109 fax 

dci.europe@digital-control.com 

India DTJ 1023, 10th Floor 

DLF Tower A, DA District Center 

Jasola, New Delhi 110044 

+91.11.4507.0444 

+91.11.4507.0440 fax 

dci.india@digital-control.com 

Russia Molodogvardeyskaya Street, 4 

Building 1, Office 5 

Moscow, Russia 121467 

+7.499.281.8177 

+7.499.281.8166 fax 

dci.russia@digital-control.com 

mailto:dci@digital-control.com
mailto:dci.australia@digital-control.com
mailto:dci.china@digital-control.com
mailto:dci.europe@digital-control.com
mailto:dci.india@digital-control.com
mailto:dci.russia@digital-control.com
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Dear Customer, 

Thank you for choosing a DigiTrak locating system. We are extremely proud of the equipment we 
have been designing and building in Washington State since 1990. We believe in providing a 
unique, high-quality product and standing behind it with superior customer service and training. 

Please take the time to read this entire manual, especially the section on safety. Also, please fill 
in the product registration card provided with this equipment and either mail it to DCI 
headquarters, fax it to us at 253-395-2800, or complete and submit the form online at our 
website, www.digitrak.com. We will put you on the Digital Control mailing list and send you 
product upgrade information and our FasTrak newsletter. 

Feel free to contact us if you have any problems or questions. Our Customer Service department 
is available 24 hours a day, 7 days a week. International contact information is available on our 
website. 

As the horizontal directional drilling industry grows, we’re keeping our eye on the future to 
develop equipment that will make your job faster and easier. Visit us online any time to see what 
we’re up to. 

We welcome your questions, comments, and ideas. 

Digital Control Incorporated 
Kent, Washington 
2013 

 

See our DigiTrak Training Videos on YouTube at www.youtube.com/dcikent. 

 

http://www.digitrak.com/
http://www.youtube.com/dcikent
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Safety Precautions and Warnings 

Carefully review this manual and be sure you always operate your DigiTrak locating system properly to 
obtain accurate depth, pitch, roll, and locate points. If you have any questions about the operation of the 
system, please contact DCI Customer Service for assistance. 

General 

 

Warning All operators must read and understand the following safety 
precautions and warnings and must review this operator’s manual 
before using the DigiTrak F5 Locating System. 

  

 

Serious injury and death can result if underground drilling equipment makes 
contact with an underground utility such as a high-voltage electrical cable or a 
natural gas line. 

 

Substantial property damage and liability can result if underground drilling 
equipment makes contact with an underground utility such as a telephone, cable 
TV, fiber-optic, water, or sewer line. 

 

Work slowdowns and cost overruns can occur if drilling operators do not use the 
drilling or locating equipment correctly to obtain proper performance. 

 

DCI equipment is not explosion-proof and should never be used near flammable 
or explosive substances. 

 

In the event of electrostatic shock, the display screen may go blank. No data loss 
will occur. Click the trigger to reset the receiver, or toggle down to reset the 
remote display. 

 

Hot surfaces can occur on cable transmitters if housing requirements are not met. 
Always ensure the transmitter is installed properly in the housing during use. 

 

Directional drilling operators MUST at all times: 

 Understand the safe and proper operation of drilling and locating equipment, including the use of 
ground mats and proper grounding procedures. 

 Ensure that all underground utilities have been located, exposed, and accurately marked prior to 
drilling. 

 Wear protective safety clothing such as dielectric boots, gloves, hard hats, high-visibility vests, and 
safety glasses. 

 Locate and track the transmitter in the drill head accurately and correctly during drilling. 

 Maintain a minimum distance of 8 in. (20 cm) from the front of the receiver to the user’s torso to 
ensure compliance with FCC requirements. 
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 Comply with federal, state, and local governmental regulations (such as OSHA). 

 Follow all other safety procedures. 

DigiTrak locating systems cannot be used to locate utilities. 

Continued exposure of the transmitter to heat due to frictional heating of the drill head can cause 
inaccurate information to be displayed and may permanently damage the transmitter.  

Remove the batteries from all system components during shipping and prolonged storage; damage 
caused by leakage may occur. 

Equipment and Battery Disposal 

 

This symbol on equipment indicates that the equipment must not be disposed of with your 
other household waste. Instead, it is your responsibility to dispose of such equipment at a 
designated collection point for the recycling of batteries or electrical and electronic 
equipment. If the equipment contains a banned substance, the label will show the pollutant 
(Cd = Cadmium; Hg = Mercury; Pb = Lead) near this symbol. Before recycling, ensure 
batteries are discharged or the terminals are covered with adhesive tape to prevent 
shorting. The separate collection and recycling of your waste equipment at the time of 
disposal will help conserve natural resources and ensure it is recycled in a manner that 
protects human health and the environment. For more information about where you can 
drop off your waste equipment for recycling, please contact your local city office, your 
household waste disposal service, or the shop where you purchased the equipment. 

The battery charger provided with your DigiTrak locating system is designed with adequate safeguards to 
protect you from shock and other hazards when used as specified within this document. If you use the 
battery charger in a manner not specified by this document, the protection provided may be impaired. Do 
not attempt to disassemble the battery charger, it contains no user-serviceable parts. The battery charger 
shall not be installed into caravans, recreational vehicles, or similar vehicles. 

Pre-Drilling Testing 

Before each drilling run, test your DigiTrak locating system with the transmitter inside the drill head to 
confirm it is operating properly and providing accurate drill head location and heading information. 

During drilling, the depth will not be accurate unless: 

 The receiver has been properly calibrated and the calibration has been checked for accuracy so the 
receiver shows the correct depth. 

 The transmitter has been located correctly and accurately and the receiver is directly above the 
transmitter in the drill head underground or at the front locate point. 

 The receiver is placed on the ground or held at the correct height-above-ground distance, which has 
been set correctly. 

Always test calibration after you have stopped drilling for any length of time. 
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Interference 

Interference can cause inaccuracies in the measurement of depth and loss of the transmitter’s pitch, 
roll, or heading. Always perform a background noise check prior to drilling. 

 Sources of interference include, but are not limited to, traffic signal loops, invisible dog fences, cable 
TV, power lines, fiber-trace lines, metal structures, cathodic protection, telephone lines, cell phones, 
transmission towers, conductive earth, salt, salt water, rebar, and radio frequencies. 

 Interference at the remote display may also occur from other sources operating nearby on the same 
frequency, such as car rental agencies using their remote check-in modules or other directional 
drilling locating equipment. 

 Background noise must be minimal and signal strength must be at least 150 points above the 
background noise during all locating operations. 

 Because this equipment may generate, use, and radiate radio frequency energy, there is no 
guarantee that interference will not occur at a particular location. If this equipment does interfere with 
radio or television reception, which can be determined by powering the equipment off and on, try to 
correct the interference using one or more of the following measures: 

o Reorient or relocate the receiving antenna. 

o Increase the separation between the receiver and affected equipment. 

o Consult the dealer, DCI, or an experienced radio/TV technician for help. 

o Connect the DCI equipment to an outlet on a different circuit. 

Equipment Maintenance 

Turn off all equipment when not in use.  

Store the equipment in cases, away from heat, cold, and moisture. Test to confirm proper operation prior 
to use. 

Clean the screens on the receiver and remote display using a damp soft cloth without chemicals or 
cleaning agents. 

Clean the receiver, remote, and battery charger case using only a soft moist cloth and mild detergent. 

Do not use chemicals to clean the transmitter. 

Inspect the equipment daily and contact DCI if you see any damage or problems. Do not disassemble or 
attempt to repair the equipment. 

Do not store or ship this equipment with batteries inside. Always remove the batteries from the equipment 
before shipping or periods of non-use. 
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Introduction 

       

LWD Application Window and Eclipse and F5 Receivers  

The DigiTrak LWD (Log-While-Drilling) DataLog System allows you to collect and store drill data 
electronically. The data is recorded using either an F5 or Eclipse receiver, and is then uploaded to a 
computer for storage and analysis. The following types of data can be measured and recorded with the 
LWD DataLog system:  

 Depth  
 Pitch 
 Elevation change (surface topography) 
 Fluid pressure, when using an F5 fluid pressure transmitter  
 Pullback force and mud pressure, when using a DigiTrak TensiTrak transmitter 
 Transmitter heading information, when using a DigiTrak SST (steering) transmitter 

This operator’s manual describes the primary components of the LWD DataLog system—the receiver, the 
transmitter, the LWD computer software, and the upload adapter used for communication between the 
receiver and the computer. It presents procedures for using the DataLog menus on the F5 receiver, 
recording data with the F5 receiver, installing the LWD software on a computer, uploading data from an 
F5 or Eclipse receiver to the computer, viewing and editing the data in the computer, and printing, saving, 
and emailing LWD drill data files.  
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The instructions in this manual primarily cover use of the system with an F5 receiver; some instructions 
for the Eclipse system are given, but Eclipse users must also refer to the DigiTrak Eclipse DataLog 
Mapping System Operator’s Manual. 

Also, as mentioned above, the LWD DataLog system is used with the TensiTrak and SST transmitters. 
For complete information on using the system with a TensiTrak transmitter, see the DigiTrak F5 
TensiTrak Operator’s Manual or the DigiTrak Eclipse TensiTrak Operator’s Manual. Also, for more 
information on the SST steering system, see the DigiTrak F5 SST Guidance System Operator’s Manual; 
the SST system requires a software upgrade for the F5 receiver. 

Some terms and techniques used in this manual are considered basic to DigiTrak locating systems. If you 
have never used the F5 or Eclipse system, then you are required to read the operator’s manual for your 
DigiTrak locating system before using the LWD DataLog system. 

NOTE: You must know how to operate your locating system prior to operating the LWD 
DataLog system. 

You must also read the instructions in this LWD DataLog system operator’s manual and familiarize 
yourself with the various menu screens on your receiver before using the system for a production drill. If 
you have questions, please call DCI Customer Service. 
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System Components 

The DigiTrak LWD DataLog system has four main components: 

 F5 or Eclipse DataLog Receiver – A locater or receiver with DataLog menus used to display and 
record transmitter data; the data is then uploaded from the receiver to a computer.  

 F5, F Series, or Eclipse Transmitter – A battery- or cable-powered device located in the drill head 
with sensors that continuously measure and transmit information about the below-ground drill 
head or product pull-force that the above-ground receiver detects and displays.  

 LWD Software – The computer application described in this manual used for uploading data from 
the receiver to a computer and for working with the uploaded data in the computer.  

 Upload Adapter – A USB device required for the computer to communicate with the F5 receiver to 
upload data, or an infrared serial cable device required to upload data from an Eclipse receiver. 

Receiver 

Either an F5 receiver or an Eclipse DataLog receiver can be used to record drill and pullback data. This 
manual gives instructions primarily for an F5 receiver; refer to the manual provided with your Eclipse 
system for instructions on using the DataLog menus in the Eclipse receiver. Instructions are included in 
this manual, however, for uploading data from either an Eclipse or F5 receiver. 

The F5 receiver can record and store 50 jobs or runs per type of DataLog file (pressure-tension or drill 
data) before uploading to a computer or deleting of jobs is necessary. Each drill data job can have up to 
250 data points. The number of data points that can be saved on each pressure-tension DataLog job is 
dependent on the amount of memory available on the F5 receiver.  

      

F5 Receiver Side View (left) and Top View (right) 

Trigger  
switch 

Toggle 
switch 

Display 
screen 

Display 
screen 

Toggle 
switch 
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The F5 receiver displays the transmitter’s temperature, roll, pitch, and battery status, and it can also be 
used to track the position and depth of a TensiTrak, F5, or F Series transmitter. The receiver must be 
programmed to detect the transmitter in use, and the system must be set up correctly for proper 
communication between the receiver, the transmitter, and the remote display. 

The DataLog menus on the F5 receiver are used to record and upload job data. There are two sets of 
DataLog menus:  

 The drill DataLog menu is used for recording and uploading pilot hole drill data with standard 
battery-operated and wireline transmitters. 

 The pressure-tension (P-T) DataLog menu is used for recording and uploading P-T data with the 
fluid pressure transmitter (FPT) and the TensiTrak transmitter.  

The DataLog menus are accessible from the Main menu and the Locate Mode screen, in some cases, 
and are described in the following section (Using DataLog Menus on Receiver). 

Transmitter 

A number of DigiTrak transmitters can be used to provide drill data, including all F5, F Series, and Eclipse 
battery-operated and wireline transmitters. Standard drill data provided by the transmitters and recorded 
by the LWD system includes depth and pitch. When a fluid pressure transmitter and the drill DataLog 
function are used, the average, high, and maximum mud pressure readings per rod are also recorded.  

 

F5 and F Series Transmitters 
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Pressure-tension data is only provided by FPTs and TensiTrak transmitters. The instantaneous mud 
pressure is recorded every 4 seconds when an FPT is used. When a TensiTrak transmitter is used, the 
maximum and instantaneous pullback force and mud pressure are recorded every 4 seconds. Depth and 
pitch are not recorded in the P-T data file.  

The transmitter and receiver must be compatible in order to record data. The F5 receiver is compatible 
with F5 and F Series transmitters (regional compatibility requirements apply). The Eclipse receiver is 
compatible with Eclipse transmitters only. 

This manual primarily gives information and instructions for using the LWD DataLog system with F5 
transmitters (including the FPT) and F Series transmitters.  

LWD Software 

The LWD software is provided on a USB flash drive that also contains this operator’s manual, the F5 
system’s operator’s manual, sample drill data, Bluetooth drivers, and software for using the system with a 
DigiTrak MFD (Multi-Function Display) remote. If you are using an MFD remote with your F5 system, 
please contact DCI for assistance in upgrading your software. 

 

LWD USB Flash Drive 

The software requires a computer with at least the following system specifications: 

 Microsoft Windows XP, Vista, or 7 operating system 
 USB port 
 Pointing device (mouse)  
 Color printer for color graphs  

Software installation instructions are provided later under the Installing LWD Software section, and 
instructions for using the LWD software are provided in the Using LWD Software section. 

A typical LWD job screen, with drill data only, is shown below. 
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LWD Drill Data Application Window (with drill data only) 

Upload Adapter 

The Bluetooth USB adapter (Amp’ed RF Model BT-210) is required for the F5 receiver to communicate 
with the computer for uploading data. The adapter has its own firmware to communicate and transfer data 
via Bluetooth technology. Drivers for the Bluetooth adapter are provided on the LWD flash drive and must 
be loaded before using the adapter to upload data (see Installing LWD Software section). 

 

Bluetooth USB Adapter 

An ACTiSYS infrared (IR) cable and possibly a USB-to-serial adapter are required to upload data from 
the Eclipse receiver. The ACTiSYS IR cable has a serial plug at one end and an IR reader at the other 
end. To download data from the receiver to the computer, the IR reader must be placed over the 
receiver’s IR port, and the serial plug must be connected to the computer. If the computer does not have 
a serial port, a serial-to-USB adapter must be used; it is provided with the IR cable. 

Instructions for uploading data from an F5 receiver or an Eclipse receiver are provided under the 
Uploading Data from Receiver to Computer section. 
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Using DataLog Menus 
on Receiver  

The DataLog menus on the F5 receiver are used to operate the LWD DataLog system. The drill DataLog 
and pressure-tension (P-T) DataLog menus have options to enable or disable the function, to manage 
drill jobs, and to upload data to a computer. When the DataLog function is enabled, additional options are 
available to set up the job and start recording data.  

Accessing DataLog Menus 

From the F5 receiver’s Main menu screen, toggle down two times to display the second screen of Main 
menu options. The drill DataLog menu is the top left option—it looks like a recording tape—and the P-T 
DataLog menu option is below it. 

 

Receiver Main Menu, First Screen 

 

Receiver Main Menu, Second Screen 

Locate mode 

Blue color indicates 
option is highlighted 

for selection  

Down arrow indicates 
more options below 
(toggle down to view) 

 

Description of 

highlighted option 

Drill DataLog menu 

(shown highlighted) 

Up arrow indicates 
more options above 
(toggle up to view) 

 

Pressure-tension  
(P-T) DataLog menu 

Settings menu 

System information 
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Click the trigger with the desired DataLog option highlighted, and you will see the DataLog menu for the 
item you selected. The menus are shown below with their default settings (drill DataLog function enabled, 
P-T DataLog function disabled). The symbols used on the DataLog menus are summarized in tables later 
in this section. 

Drill DataLog Menu 
 

The drill DataLog menu provides the options needed to record pilot hole drill data electronically. It 
appears on two screens. The first screen is shown below; the second screen provides the exit option.  

 

Drill DataLog Menu  

Pressure-Tension (P-T) DataLog Menu 
 

The pressure-tension (P-T) DataLog menu is used with the fluid pressure transmitters and the TensiTrak 
transmitter.  

 

P-T DataLog Menu  

Toggle down for exit 
option (to return to 
Main menu) 

 

Enable/disable P-T 
DataLog function  
(green if enabled,  
red if disabled) 

Exit (returns to 
Main menu)  

 

“p” indicates a fluid 
pressure transmitter is 
selected 

Delete drill DataLog  
job or jobs 

Add survey point 

View drill DataLog jobs 

 

Set up drill DataLog job 

(shown highlighted) 

Upload drill DataLog 
job to a computer  

Enable/disable drill 
DataLog function  
(green if enabled,  

red if disabled) 

Description of 
highlighted option 

 

Delete P-T DataLog 
job or jobs 

Upload P-T DataLog 
job to a computer 

(shown highlighted) 



Using Receiver Menus  

18 DigiTrak
®
 LWD™ DataLog

®
 Operator’s Manual 

DataLog Recording Menus 

When a pressure sensing transmitter is used and the P-T DataLog function is enabled, the Start 
Recording menu (shown below) will display every time the Locate Mode screen is accessed. This menu 
allows you to start recording by appending to an existing job or creating a new job. 

 

P-T DataLog Start Recording Menu 

The Start Recording menu for the drill DataLog function has the same options as that shown above for 
the P-T DataLog function, and the options perform the same functions, as described in the “DataLog 
Menu Symbols” table below. 

When a job is being recorded and you exit the Locate Mode screen (toggle down), the option to stop or 
pause the job appears on the screen, as shown below. 

 

Drill DataLog Stop/Pause Recording Menu 

Select pause to enter the Main menu while keeping the job open. The DataLog job will be ready to record 
more data from the Locate Mode screen until the receiver is shut down or the job is stopped and closed. 

Stop job 
Pause job 
(shown 
highlighted) 

Append to an 
existing job 

(shown 
highlighted) 

Create a  
new job 

Exit (returns to 

`)  
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DataLog Menu Symbols 

The drill and pressure-tension DataLog functions use the same menu symbols for options that perform 
identical functions. The common DataLog menu items are summarized below.  

 

Upload Job – Uploads DataLog job data from the receiver to a computer with 
DigiTrak LWD software installed. A maximum of 50 DataLog jobs or runs per file 
type (drill data or pressure-tension) can be stored in the receiver before uploading 
to a computer is required.  

 

Delete Job – Deletes the selected DataLog job from the receiver. You can delete 
one job at a time or all the jobs at once. This symbol is also used in the delete job 
Menu to select one job to delete. 

 /  

Enable DataLog / Disable DataLog – When “Disabled, click to enable” shows, 
the icon is red and the DataLog function is disabled in the receiver; no logging can 
occur. When “Enable, click to disable” shows, the icon is green and the DataLog 
function is enabled; you can access the DataLog menu options from the Locate 
Mode screen. 

 

Create a New Job – Starts a new DataLog job. When using the drill DataLog 
function, you will be prompted to set up the job with rod lengths. When using the 
pressure-tension DataLog function, the Locate Mode screen will appear and 
logging will begin. 

 

Append to an Existing Job – Continues adding data to an existing DataLog job. 
You must select the job number from the list. A maximum of 50 DataLog jobs per 
file type (drill data or pressure-tension) can be saved for appending. 

 

Pause Job – Opens the Main menu and keeps the job open with no data 
recording. When you re-enter the Locate Mode screen without shutting down the 
receiver, data will continue to be recorded on the job number indicated. 

 

Stop Job – Saves and closes a DataLog job. The job can be reopened, 
appended, viewed, and uploaded until it is deleted from the job list. 

 

Delete All Jobs – Deletes all drilling jobs stored in the receiver. All existing jobs 
will be selected for deletion from the receiver. 

 

Confirm Delete – Appears after a delete jobs option has been selected to confirm 
the deletion of job data. Select this option to confirm deletion or select exit to 
cancel deletion. 

 

Set a Flag – Records a flag while a P-T DataLog job is running. Flags can be 
recorded at fixed intervals or at specific points along the bore path to help cor-
relate physical locations with the recorded data points. 
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Drill DataLog Menu Symbols 

Symbols that are used specifically for the drill DataLog function are summarized below.  

 

Set Up Job – Sets up a new job or appends data to an existing job. This option is 
only accessible when the drill DataLog function is enabled. If no drill DataLog job 
has been started, this option can also be accessed from the Locate Mode screen 
by holding the trigger in and toggling right. Used to program the average pipe 
length (drill rod length) and the 1

st
 rod length (typically approximately 70% of an 

average rod).  

 

Add Survey Point – Allows you to record a surveyed value for the difference in 
elevation (reference elevation) between the start and end of the bore. This value 
will help provide a more accurate profile graph in the LWD software. 

 

View Job Data – Allows you to select a specific job and view the data for that job. 

 

Record Depth and Pitch – Logs the depth and pitch information at a data point 
[either the front locate point (FLP) or the locate line (LL)]. This option will be 
grayed out (not available for selection) at the first rod data point and when pitch or 
depth information is not available. 

 

Record Pitch – Logs only the pitch information at a data point; for use when the 
receiver cannot be positioned over the FLP or LL. This option will be grayed out if 
pitch information is not available, in which case you must record a blank rod. 

 

Record Blank Rod – Logs a data point with no pitch or depth information; for use 
when the receiver cannot be positioned within range of the transmitter. 

 

Record Partial Rod – Logs a data point after finishing a partial rod (¼, ½, or ¾ of 
a rod). This is recommended when using long drill rods during significant pitch 
changes or to plot small changes in topography accurately. 

 

View/Delete Rod Data – Shows all logged data points and can be used to delete 
the last logged data point.  

 

 

Setting Time and Calendar 
 

The correct time and date must be programmed into your receiver before logging data. The option to set 
the time and calendar is available on the Settings option on the Main menu. For additional help on setting 
the time and date for your receiver, consult your operator’s manual, which is available at DCI’s website. 
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Recording Drill Data  

To record pilot bore drill data, the F5 receiver must be properly programmed for and calibrated to the 
transmitter, with the calibration verified. If both pressure and drill data will be recorded, you should set up 
to record drill data before you begin the pressure log. The correct procedure for recording drill data is 
described in this section. The procedure for recording pressure-tension data is given in the next section.  

Creating a New Job  

1. From the Locate Mode screen, hold the trigger in while pushing the toggle to the right one time to 
display the Drill DataLog Start Recording menu. 

 

Drill DataLog Start Recording Menu 

2. Select Create a New Job. A keypad will appear to enter the pipe length (drill rod length) to be used for 
that bore. Enter the pipe length, then select the curved arrow button to record it as the drill rod length. 

 

Keypad for Entering Pipe Length (Rod Length) 

Units for pipe/rod 
length are set using 
depth units option 

on Settings menu 

Append to an 

existing job  

Create a new job 
(shown highlighted) 

Exit (returns to 

locate mode)  

Exit (returns to 

locate mode)  
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3. To find the 1
st
 rod length, measure from the make-up/break-out clamps to the top of the rod when the 

tool is positioned for the first data point, as shown below. For this measurement, the housing slots 
should be half above and half below the ground (or a plane parallel to the ground if drilling into a pit). 
The elevation at the first data point is the Zero Reference elevation, and is generally at the surface of 
the ground. 

 

Measuring the 1st Rod Length 

4. The 1
st
 rod length screen appears with a default value displayed in the 1

st
 Rod Length window. The 

default 1
st
 rod length is automatically calculated as 70% of your pipe length. If this number is correct 

for your bore, simply select the green checkmark to set this value. To set a different value, select the 
keypad, enter the desired value, and select the curved return arrow button. 

 

1st Rod Length Input Screen 

If you are using a fluid pressure transmitter, DCI recommends that you begin the pressure log at this 
time. See the Recording Fluid Pressure Data section below. 

5. Select Exit to return the Locate Mode screen, hold the trigger, and toggle right to open the Drill 
Datalog Recording Options menu. 

Top of rod 

Slots in housing 

1
st

 rod length 

Make-up/break-out 
clamps 

Drill 
carriage 

Zero elevation 
reference line  

Surface of 
ground  

Set 1
st

 rod length  
to default value  

(shown highlighted) 

Select keypad to 
enter different value 

Exit (returns to 

locate mode)  
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6. When recording the first data point (rod 0), the only available option will be Pitch Only. With the 
receiver positioned within range of the transmitter (it does not have to be at the locate line or front 
locate point), select the Record Pitch Only icon to record the data point. The receiver beeps twice and 
returns to the Locate Mode screen. 

 

Drill DataLog Recording Options (Pitch Only) 

7. Advance the drill head to the end of the first rod and position the receiver over the locate line (LL) or 
the front locate point (FLP). 

8. Hold the trigger in and toggle right to display the Drill Data Recording Options menu, which now has 
all options enabled.  

 

Drill DataLog Recording Options  

9. Select Record Depth/Pitch (or Record Pitch Only if you are not able to position the receiver at the LL 
or FLP) and click the trigger to record the second data point (rod 1). The receiver will beep several 
times and return to the Locate Mode screen. 

10. Continue drilling and recording data points at the end of each drilled rod or at partial rod intervals, 
pulling back and deleting rods if necessary. Both procedures are described in the following section. 

Record depth and pitch  
(not available)  

 

Record pitch only 
(shown highlighted) 

Log a blank rod 
(not available) 

Record depth/pitch  

(shown highlighted)  

Record pitch only  

Log a blank rod  
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Recording Rods or Partial Rods 

The DigiTrak LWD software requires that data points be recorded at equally spaced intervals, such as at 
the end of each drill rod. However, when you are drilling with long drill rods and/or making significant pitch 
changes, you should record data at partial pipe length intervals. This will more accurately depict the bore 
profile and changes in topography. It is possible to record at ¼, ½, ¾, or full pipe lengths.   

The method for recording rods and partial rods is the same; however, partial rods may only be recorded 
after rod 0 (first data point) and rod 1 (second data point) have been recorded. Use the following 
procedure to record a rod or partial rod. 

1. Position the receiver at the FLP or over the head at the LL, if possible. 

2. Hold the trigger in and toggle right. The recording options screen will display.  

 

Drill DataLog Recording Options (First Screen) 

If you are recording a partial rod, you must toggle down to view the second screen of recording 
options, where you can select the partial rod option before continuing. 

 

Drill DataLog Recording Options (Second Screen) 

Record depth and pitch  

(shown highlighted)  

Down arrow indicates 
more options below 
(toggle down to view) 

 

Record pitch only  

Log a blank rod  

Record data at 
partial rod lengths 

(shown highlighted) 

View/delete rod data  

Exit (returns to 
locate mode)  

Rod length (full, 1/4, 1/2, 
3/4, or finish depending 

on whether a full or 
partial rod is selected)  
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After a partial rod option is chosen, the display will return to the first recording options screen but the 
partial rod value (¼, ½, ¾, or finish rod) will appear in place of “Full Rod” for the rod length. If a partial 
rod data point is recorded, another data point must be recorded at the end of the rod as well. The 
“Finish Rod” option appears if a partial rod was previously recorded.  

3. To record the data point, select the option to record depth and pitch (or pitch only if you are not able 
to position the receiver at the LL or FLP) and click the trigger. The receiver will beep several times 
and return to the Locate Mode screen. 

Pulling Back Rods / Deleting Data from Receiver 

If you need to pull back or delete rods to redirect the tool, use the option to view/delete rod data located 
on the second screen of the DataLog Recording Options menu (shown below). The procedure for deleting 
rods follows. 

 

Drill DataLog Recording Options (View/Delete Rod Data) 

1. Select the view/delete rod data option, and click the trigger. You will see a list of the recorded rods 
with the most recent rod data in the top row, which will automatically be highlighted. Only the most 
recent rod can be deleted. 

 

View/delete rod data 

(shown highlighted) 
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View Rod Data List 

NOTE: If you have accessed the screen above and do not want to delete the data point, toggle left 
or right to exit and return to the Locate Mode screen without deleting the data point. 

2. Click the trigger, to select the data point for the highlighted rod. The following screen will display.  

 

Delete Rod Screen 

3. Select the green checkmark to delete the last rod data point. Or select exit to return to the Locate 
Mode screen without deleting the data point. 

4. Continue these steps, highlighting a rod in the list then clicking to delete it and confirm deletion, until 
you have deleted as many rods as needed. When done, toggle to the right one time to return to the 
Locate Mode screen.   

Measuring and Documenting Last Rod 

When the drill head reaches the end of the bore and exits the ground, you must measure and document 
the length of the last rod so that you can enter it when you upload the drill data to the computer. The last 
rod measurement is the pipe length minus the length of drill rod left on the rack. For example, if you 

Survey point (appears 
blank unless value is 
entered under Survey 

Point menu option)  

Data for most 

recent rod  

Exit (returns to 
locate mode)  Delete most recent 

rod data point 
(shown highlighted) 
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measure 6 ft (1.8 m) from the make-up/break-out clamps to the top of the rod, then you would subtract 
6 ft (1.8 m) from the pipe length. If the pipe length is 10 ft (3.0 m), then the last rod measurement will be 
4 ft (1.2 m).  

 

Last Rod Measurement 

NOTE: You must write down the last rod measurement; it does not get recorded with the drill 
data in the receiver. You will need to enter the value manually after the job is uploaded 
to the computer. 

 

Make-up/break-out  
clamps 

Drill rods 

Slots in 
housing 

6 ft (1.8 m) rod length left on rack 
Ground surface 
(topography) 

Zero elevation 
reference line 

Drill  
head 

Termination/ 
end point 

Pipe length  
(10 ft/3.0 m) 

Drill 

Top of rod 
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Stopping or Pausing Recording 

You must stop the DataLog job after recording the last data point and documenting the last rod so that 
you can close the file and upload the recorded data. However, you can also pause a DataLog job and 
keep it open while navigating menu options. All DataLog jobs are closed automatically when the receiver 
shuts down. The procedure for stopping or pausing a DataLog job is described below.  

1. Toggle down to exit the Locate Mode screen and open the drill DataLog Stop/Pause Recording 
menu.  

 

Drill DataLog Stop/Pause Recording Menu 

2. Select the stop option to close the DataLog job. The drill DataLog job can then be uploaded to a 
computer with LWD software installed or opened again using the append option in the drill DataLog 
Start Recording menu. 

-OR- 

Select the pause option to keep the job open for additional recording. When you re-enter the Locate 
Mode screen and record another data point, data will continue recording on the job that was 
previously paused. 

If you want to include utilities information with your drilling data, you must log by hand the depth, 
description, rod number, and/or distance from the launch point for each utility location. When you upload 
your data to the computer, you can enter these utilities and any other landmark features so that they are 
plotted with the drill data.  

NOTE: You cannot save more than 20 runs in the receiver at any one time. If you attempt to 
store more than 20 runs before deleting data, you could lock up the receiver and lose all 
drill data it has stored. This may require the receiver to be returned to DCI for repair. 

 

 

Stop job  
Pause job  
(shown highlighted) 
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Appending to a Job 

To add data to a drill DataLog job that has already been started and closed, you will use the append 
option in the Start Recording menu, as described below. 

1. From the Locate Mode screen, hold the trigger in while pushing the toggle to the right one time to 
display the following screen.  

 

Drill DataLog Start Recording Menu 

2. Select the option to append to an existing job. The list of drill DataLog jobs stored on the receiver will 
display as shown below. 

 

Sample Drill DataLog Jobs List Stored on Receiver 

3. Select the job number you would like to open and append with more data. The drill DataLog recording 
options screen will display so that you can continue to log data points.  

4. Continue recording rods or partial rods as described earlier in this section. 

 

“L” indicates a  
drill DataLog job  

(“PT” displays for 
pressure-tension 

DataLog jobs)  

Append to an  
existing job  

(shown highlighted) 

Create a  
new job 

Exit (returns to 
locate mode) 
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Adding a Survey Point 

If the difference in elevation between the ground level at the entrance and that at the exit of a drill path 
has been surveyed, then you can enter this value as a survey point to provide a more accurate graph of 
the bore and terrain in the LWD software. The procedure is given below. 

1. Open the drill DataLog menu from the receiver Main menu. 

2. Select the add survey point option (icon is shown to the right). The list of 
existing drill jobs will display. 

3. Select the job you would like to add the survey point to. The following screen will 
display. 

 

Survey Point Menu 

4. Select the keypad option. The following screen will display. 

 

Survey Point Keypad Menu (meters) 

Open keypad to 
enter known 
elevation difference 
(shown highlighted) 

Set survey point 
back to unknown 

(the LWD software 
will calculate the 

elevation difference) 

 

Survey Point 
Menu Option 

+/- option for setting 
positive or negative 

survey point value 

Units for survey 
point are set using 
depth units option 

on Settings menu 
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The survey point keypad menu operates like the other keypad menus in the F5 receiver except that it 
has a “+/-” option because the elevation difference can be positive or negative. The keypad assumes 
the value will be positive, meaning the exit point has a higher elevation than the entrance point. To 
change the value from positive to negative or vice versa, select the +/- option. 

5. Enter the surveyed value for the difference in elevation between the entrance and exit of the bore one 
digit at a time, left to right. 

6. Select the curved arrow button to set the displayed value as the survey point value. The screen will 
return to the DataLog menu with the exit open selected. 

Deleting DataLog Jobs 

1. Open the drill DataLog menu from the receiver Main menu. 

2. Select the menu option to delete a job or jobs (icon is shown to the right). The 
delete DataLog Jobs menu will display, as shown below.  

 

Delete DataLog Jobs Menu 

3. To delete one job, select the delete one job option. The list of available DataLog jobs will display 
where you can select the job to delete. 

-OR- 

To delete all jobs, select the delete all jobs option. 

4. A confirmation screen will display.  

Delete one job Delete all jobs 
(shown 

highlighted) 

 

Delete Job 
Menu Option 
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Confirm Job Deletion Screen 

Select the option to confirm the deletion or select exit and return to the delete DataLog Jobs menu 
screen without deleting the job or jobs. 

Once you delete a job from the receiver, you cannot recover it. Make sure you have uploaded all jobs to 
the computer before you delete jobs from the receiver. 

 

Confirm job deletion 

(shown highlighted) 

Exit without 

deleting job 
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Recording Fluid Pressure Data 

To record fluid pressure data, the F5 receiver must be properly programmed for and calibrated to the fluid 
pressure transmitter (FPT), with the calibration verified, and the pressure-tension (P-T) DataLog function 
must be enabled. If both pressure and drill data will be recorded, you should set up to record drill data 
before beginning the pressure log. The correct procedure for recording drill data is described in the 
previous section. The procedure for recording pressure data is given in this section. 

Creating a New P-T DataLog Job  

1. With the P-T DataLog function enabled, select the Locate Mode option from the receiver Main menu. 
The P-T Start Recording menu shown below will appear.  

 

P-T DataLog Start Recording Menu 

2. Select the option to create a new job, noting the job number that displays at the bottom of the screen. 
If the exit option is chosen, no P-T DataLog job will be opened and this screen can be accessed 
again from the Locate Mode screen by toggling right. 

3. After you have chosen to create a new job, the Locate Mode screen will display and data will begin 
recording immediately, as indicated by the recording symbol next to the roll indicator as shown below.  

 

Transmitter Roll Indicator with P-T Data Recording On 

Exit (opens locate  
mode screen; no data 
recording will occur)  

 

Append to an  
existing job  

(opens an existing  
job to continue  
recording data) 

Create a new job  
(opens locate mode 
screen; data will be 
recorded under indi-
cated job number) 
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Recording Data Flags in P-T File 

The Flag Recording menu is accessible only when a P-T job is already running and the receiver is in 
locate mode. DCI recommends that you record flags at fixed intervals and at critical points along the bore 
path, such as before and after crossing under a roadway or stream, to help correlate physical locations 
along the pullback/drill path with the P-T file data points.  

1. From the Locate Mode screen, push the toggle switch to the right to display the Flag Recording menu 
shown below. 

 

DataLog Flag Recording Menu 

2. To record a flag, select the option to set a flag. Once a flag is recorded, it cannot be deleted from the 
P-T data file. If you do not want to set a flag, toggle right and select exit to return to the Locate Mode 
screen without recording a flag. 

3. Keep a separate log of the flag numbers and details of the location where each flag was recorded 
(such as entering under road, exiting under road, etc.). You will want to add this information to the P-
T data file after it is uploaded to a computer.  

Stopping or Pausing Recording 

You must stop the P-T DataLog job so that you can close the file and upload the recorded data. However, 
you can also pause a P-T DataLog job and keep it open while navigating menu options. All DataLog jobs 
are closed automatically when the receiver shuts down. The procedure for stopping or pausing a DataLog 
job is described below. 

Exit (returns to locate 
mode screen without 
recording a new flag)  

 

Set a flag  
(records flag 

number indicated 
on locate mode 

screen) 
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1. Toggle down to exit the Locate Mode screen and open the P-T DataLog Stop/Pause Recording 
menu. If drill data is also being recorded, the drill DataLog Stop/Pause Recording menu will appear, 
followed by the P-T Stop/Pause Recording menu shown below. 

 

P-T DataLog Stop/Pause Recording Menu 

2. Select the stop job option to close the P-T DataLog job. The job can then be uploaded to a computer 
with LWD software installed or opened again using the append option in the P-T DataLog Start 
Recording menu.  

-OR- 

Select the pause job option to keep the job open for additional recording. When you re-enter the 
Locate Mode screen, data will automatically continue recording on the job that was previously 
paused. 

NOTE: You cannot save more than 20 runs in the receiver at any one time. If you attempt to 
store more than 20 runs before deleting data, you could lock up the receiver and lose all 
drill data it has stored. This may require the receiver to be returned to DCI for repair. 

 

Stop job  

Pause job 
(shown 
highlighted) 
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Appending to a P-T Job 

To add data to a P-T DataLog job that has been previously started and closed, use the Append option in 
the Start Recording menu as described below. 

1. Open the P-T DataLog Start Recording menu from the Locate Mode screen.  

 

P-T DataLog Start Recording Menu 

2. Select the option to append to an existing job. The list of P-T DataLog jobs stored on the receiver will 
display as shown below. 

 

Sample P-T DataLog Jobs List Stored on Receiver 

3. Select the P-T DataLog job number you would like to open and append with more data. The Locate 
Mode screen will display and data will continue recording automatically. 

 

 

“PT” indicates a 
pressure-tension 

DataLog job  
(“L” displays for  

drill DataLog jobs)  

 

Append to an  
existing job  

(shown highlighted) 

Create a  
new job 
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Deleting P-T DataLog Jobs 

1. Open the P-T DataLog menu from the receiver Main menu.  

2. Select the menu option to delete a job or jobs (icon is shown to the right). The 
delete DataLog Jobs menu will display, as shown below.  

 

Delete DataLog Jobs Menu 

3. To delete one job, select the delete one job option. The list of available P-T DataLog jobs will display 
where you can select the job to delete. To delete all jobs, select the delete all jobs option. 

4. A confirmation screen will display, as shown below.  

 

Confirm Job Deletion Screen 

Select the option to confirm the deletion or select exit and return to the delete DataLog Jobs menu 
screen without deleting the job or jobs. 

Once you delete a job from the receiver, you cannot recover it. Make sure you have uploaded all jobs to 
the computer before you delete jobs from the receiver. 

 

Delete one job Delete all jobs 
(shown 

highlighted) 

 

Delete Job 
Menu Option 

Confirm job 
deletion  
(shown 

highlighted)  
Exit without 

deleting job 
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Installing LWD Software  

Computer System Requirements 

The LWD software requires a computer with at least the following system specifications: 

 Microsoft Windows XP, Vista, or 7 operating system 
 USB port 
 Pointing device (mouse)  
 Color printer for color graphs  

The LWD software is provided on a USB flash drive that also contains this operator’s manual, sample drill 
data, Bluetooth drivers, and software for using the system with an MFD remote. If you are using an MFD 
remote with your F5 system, please contact DCI Customer Service so that we can assist you in upgrading 
your MFD software. 

Installation Instructions 

The LWD program files will automatically be placed under the C:\Program Files folder in a new folder 
(C:\Program Files\DCI\DigiTrakLWD). You can change this default storage location during installation.  

The LWD data files and sample data files will automatically be placed under My Documents\DCI. You can 
also change this default storage location during installation. 

To install the LWD software: 

1. Close any open applications.   

2. Put the LWD flash drive into a USB port and view the contents of the drive in your computer. Click on 
the LWD Kit folder.  

3. Double-click on Drivers for LWD to install these first. 

4. Double-click on the Bluetooth Driver folder, then double-click on the *.exe file to install the drivers. 

5. Double-click on the DigiTrak LWD Software folder, and then double-click on the setup.exe file to 
install the LWD software. 

6. Once the LWD drivers and software have been installed, you will see a shortcut icon  on your 

desktop and under All Programs in your Start menu (in lower left corner of computer screen).  
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You can start the program by using the LWD shortcut icon or the Start button path or by clicking on the 
DigiTrakLWD.exe file in Windows Explorer. When the program opens, a blank LWD application window 
will display, as shown below.  

 

LWD Blank Application Window 

For instructions on using the LWD software, see the Using LWD Software section. 
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Uploading Data  
from Receiver to Computer 

The instructions for uploading DataLog jobs from the F5 receiver to your computer are provided below. 
The procedure involves adding the F5 receiver to the LWD software’s Bluetooth device list and then 
uploading the files to the computer via the Bluetooth connection. Only basic instructions for using the 
LWD software to upload data are discussed here. For full instructions on using the LWD software, see the 
next section, Using LWD Software.  

Uploading DataLog jobs from an Eclipse receiver requires the infrared cable and USB-to-serial adapter (if 
necessary) provided with the Eclipse DataLog system. The correct procedure for uploading data from an 
Eclipse receiver is described later in this section. 

Adding F5 Receiver to LWD Bluetooth Device List 

The first time a new F5 receiver is used with the LWD software on your computer, you will need to add it 
to the Bluetooth device list in the LWD software.  

First, power up both the F5 receiver and the computer. Then, insert the Bluetooth USB adapter (Amp’ed 
RF Model BT-210) into a USB port on the computer. Continue with the procedure as follows. 

On the Receiver 

1. Open the system information screen from the receiver Main menu by selecting 
the system information option (icon shown to the right).  

2.  Note the receiver identification number and the Bluetooth device address, which 
you will need to enter into the LWD software on the computer.  

 

Receiver System Information Screen 

Receiver 
identification 

number  

Bluetooth device 
address  

 

System  
Information 
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On the Computer 

1. Start up the LWD program by using the LWD shortcut icon or the Start button path or by clicking on 
the DigiTrakLWD.exe in Windows Explorer. 

2. Select the View | Bluetooth Device List option on the menu bar or click on the Bluetooth icon  in 

the toolbar to open the Bluetooth Device List dialog box. 

 

Bluetooth Device List Dialog Box 

3. Enter the Bluetooth device address from the receiver system information screen in the specified text 
field.  

4. Enter a name for the F5R device in the Bluetooth device name text field. We recommend that you use 
the receiver identification number shown on the receiver system information screen in the name. 

5. Click on Add.  

6. Click on OK. The device you added will appear in the Bluetooth device list. 

You are now ready to upload job data. 

 

Uploading Data from the F5 Receiver  

Once the F5R device has been added to the Bluetooth device list, you can upload DataLog files. DCI 
suggests that you upload data to a computer following every DataLog job. The Bluetooth adapter must 
remain in the USB port of the computer during the upload process. 

On the Receiver 

1. Open the DataLog menu for the type of job file you are uploading (drill data or pressure-tension). 

Bluetooth devices 

previously added  

Address text field  

Name text field  
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2. Select the option to upload a job, and the DataLog job list for the type of job file selected will display 
as shown below.  

 

Sample List of Drill DataLog Jobs Stored on Receiver 

3. Select the job to upload. Continue the procedure with the instructions below for actions to perform at 
the computer to complete the data upload. Data must be communicated within 15 minutes or the 

receiver will shutdown. 

On the Computer 

1. Start up the LWD program. 

2. Select the File | New command on the menu bar or click on the new file icon  in the tool bar.  

3. Select the type of file you would like to upload (drill data or pressure-tension) click on OK, a blank 
form will display.  

4. Select File | Upload Control command on the menu bar or click on the connection icon  in the 

tool bar. The Upload Control dialog box will display.  

5. Select the Bluetooth radio button option. 

6. Select “Silicon Labs CP210x USB to UART Bridge (COM#)” from the Serial Port Connection pull-
down list.  

7. Select the F5 receiver name from the Bluetooth pull-down list.  

8. Click on the Connect to Device button to establish communication and begin the data transfer. 

9. After the data has been transferred, the DataLog Job Information dialog box will appear. You may 
choose to enter the requested details now or later. 

10. Click on OK. The data information fields and chart areas in the LWD application window will fill with 
data.  

“L” indicates a  
drill DataLog job  

(“PT” displays for 
pressure-tension 

DataLog jobs)  

DataLog job number 
highlighted for 

selection  
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Uploading Data from Eclipse Receiver 

To upload data from an Eclipse receiver to the computer, you will need the ACTiSYS IR cable provided 
with the Eclipse DataLog system and, if you do not have a serial port on your computer, you will need the 
USB-to-serial adapter. The IR cable has a serial plug at one end and an IR reader at the other end. 
Follow the instructions given below to upload your data. 

On the Computer 

1. Plug the ACTiSYS IR cable into the serial (COM) port on the computer, or use the USB-to-serial 
adapter to connect the cable to a USB port. 

2. Start up the computer. 

3. Start up the LWD program by using the LWD shortcut icon or the Start button path or by clicking on 
the DigiTrakLWD.exe in Windows Explorer. 

4. Select the File | New command on the menu bar or click on the new file icon  in the tool bar.  

5. Select the type of file you would like to upload (drill data or pressure-tension) click on OK; a blank 
form will display.  

6. Select File | Upload Control command on the menu bar or click on the connection icon  in the 

tool bar. The Upload Control dialog box will display.  

7. Select the Infra-Red radio button option. 

8. Select the communication (COM) port assigned to the IR cable from the Serial Port Connection pull-
down list. 

On the Receiver 

1. Start up the Eclipse receiver.   

2. From the Main menu screen push the toggle to the right a few times to select the DataLog option, 
and click the trigger.  

3. Select the DataLog option for the type of file you are uploading. 

4. Select the Send Data option, and click the trigger. 

5. A pop-up box appears that shows the last run logged. Select the correct run for the upload. 

6. Align the IR reader on the end of the IR cable with the red IR port on the left side of the receiver’s 
display window, and click the trigger to begin the upload process. The drill data will appear imme-
diately on the computer screen if the upload is successful. 
 

Uploading Recommendations 

DCI recommends that you upload data for each run at least twice, and save each with a different name. 
For example, you could upload and save the data the first time as "Riverbore" and the second time as 
"Riverbore Rev 1". 
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If you have recorded a data point using the pitch-only or blank rod option, then that data point will appear 
to be missing data once you have uploaded the file. The LWD software will make assumptions to fill in the 
missing data or you can change these values as desired in the software.  

See the next section, Using LWD Software, and the help files in the LWD software for more information 
on interpreting, editing, and sharing DataLog job information. 
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Using LWD Software 

Starting LWD Program and Opening Files 

There are three ways to start the LWD program:  

 Double-click on the LWD icon  on the desktop. 

 Use the Start button (in lower left corner of computer screen) and select Start | All Programs | 

Digital-Control, Inc | DigiTrakLWD |    DigiTrakLWD. 

 From Windows Explorer, click on the DigiTrakLWD.exe file under the default folder C:\Program 
Files\DCI\DigiTrak LWD or in the folder you have designated for the storage location.  

After you start up the program, the application window will display without data, as shown in the Installing 
LWD Software section. From the blank application window, use the File | New command on the menu bar 

(or the new file icon  in the tool bar) to start a new DataLog job file. You must choose which type of 

job file you want to start: drill data, pressure-tension, or steering. If you choose drill data, a blank form as 
shown below will display. 

 

LWD Drill Data Application Window (without data) 

Menu bar 

Job 
information 

Site  
information 

Data 
point list 

Chart 
area 

Tool bar 

 

Status bar 
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The blank form for pressure-tension files contains the same fields but has slightly different features for the 
different types of data it displays. The blank form for steering files (which are not dealt with in this manual) 
is also slightly different. 

To open an existing drill data or pressure-tension DataLog file from the blank application window, use the 

File | Open command (or the file open icon ). You can also open a DataLog file directly from 

Windows Explorer. The file extension for a drill DataLog file is *.dl5, and the file extension for a pressure-
tension file is *.tt5. When a file is opened, the data information fields and the charts are filled with data, as 
shown below. 

 

LWD Drill Data Application Window (with data) 
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LWD Pressure-Tension Application Window (with data) 

The LWD application menus and tool bar icons are described in the following subsection, and the 
different information fields (site information, job information, data point list, and chart area) common to the 
drill data and pressure-tension files are described afterward. Features unique to drill data files and to 
pressure-tension files are then discussed in separate subsections, including how to edit data in the files. 
Instructions for printing, saving, and e-mailing files are given at the end of this section. 

We recommend that you review the help files in the LWD software for more information. The tool tip 
helper can also be used to understand different parts of the application window and file. Click on the tool 

tip helper icon  on the tool bar and click on a point of interest within the file to open a help window 

with information about the point of interest.  
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Menu and Tool Bars 

Under each menu item on the menu bar (File, Edit, View, Window, and Help) are commands for running 
the LWD program. Many of the commands are similar to those used in other Windows programs and 
have associated icons on the tool bar. The menu commands and associated tool bar icons are 
summarized below. You can also move the cursor over any icon on the screen for a brief description of its 
function. Icons or menu items are grayed out (unavailable) when they do not pertain to the currently open 
DataLog file type. 

File Menu Commands 

New 
 

Opens a dialog box where you select the job type to be created (drill data, 
pressure-tension, or steering). Once a selection is made, a new blank job 
screen appears. 

Open 
 

Allows you to select an existing project to open from a Windows Explorer 
dialog box. 

Save 
 

Saves an open project using the same file name and folder as designated 
previously. 

Save As  Opens the Save As dialog box to save the open job to a specified file name 
and folder. When a new file has not yet been saved, selecting the save icon 
on the tool bar will open the same screen as the Save As menu command. 
NOTE: DCI recommends saving DataLog files often and with different names. 

Print  Opens the Print dialog box where you can select printing options and print the 
job. 

Print Preview  Displays the project on the screen as it would appear printed. 

Print Setup  Allows you to select a printer and printer connection as well as the paper size 
and orientation. 

Import 
Eclipse Data 

 Allows you to import an Eclipse DataLog file (*.dld) or Eclipse TensiTrak file 
(*.ttd) previously saved on a computer.  

Export 
Spreadsheet 

 Exports a spreadsheet-compatible comma-separated value (*.csv) Unicode 
text file so you can share charts using standard spreadsheet software. 

Upload 
Control 

 Launches an Upload Control dialog box where you can link to a receiver for 
uploading files.  

File 1, 2…  Opens the specified previously opened file. 

Exit  Exits DigiTrak LWD program. 
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Edit Menu Commands 

Site 
Information 

 
Opens the Site Information dialog box where you can enter and edit the 
location and contact information that displays in the site information field in the 
upper left corner of the application window. General comments about the job 
may also be entered in the Site Information dialog box. This dialog box can 
also be accessed by double-clicking in the site information field of the 
application window.  

Display   
 

Opens the Display Units dialog box where you can select the depth, pitch, 
temperature, and force/pressure units displayed on the charts in the appli-
cation window. The depth unit setting in the receiver will determine the units 
that will display.  

Job 
Information 

 
Opens the Job Information dialog box where you can view receiver and job 
details and edit some data, including rod length and survey point information 
for drill data files, and information about the product being installed for 
pressure-tension files. This dialog box displays immediately after uploading a 
DataLog File and can also be opened by double-clicking anywhere in the Job 
Information field.  

Profile  
Chart 
Annotations 

 
Opens the Profile Chart Annotations dialog box where you can make 
comments and insert drawings to appear on the profile chart. This dialog box 
can also be opened by holding the shift key down and using the mouse button 
to draw a box in the profile chart field. 

Pressure 
Chart 
Annotations 

 
Opens the Pressure Chart Annotations dialog box where you can make 
comments and insert drawings to appear on the pressure chart. This dialog 
box can also be opened by holding the shift key down and using the mouse 
button to draw a box in the pressure chart field. 

Force  
Chart 
Annotations 

 
Opens the Force Chart Annotations dialog box where you can make 
comments and insert drawings to appear on the force chart. This dialog box 
can also be opened by holding the shift key down and using the mouse button 
to draw a box in the force chart field. 

Profile  
Chart 
Properties 

 
Opens the Profile Chart Extents and Mode dialog box where you can adjust 
the scaling of the Profile Chart. 

Pressure 
Chart 
Properties 

 
Opens the Pressure Chart Extents and Mode dialog box where you can adjust 
the scaling of the Pressure Chart. 

Force  
Chart 
Properties 

 
Opens the Force Chart Extents and Mode dialog box where you can adjust 
the scaling of the Force Chart. 

Utility Flags 
 

Opens the Utility Flags dialog box where you can add, change, or delete flags 
and data regarding utilities. 

Data Flags 
 

Opens the Pressure-Tension Data Flags dialog box where you can change or 
delete P-T data flags. 
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View Menu Commands  

Toolbar  Shows or hides the tool bar. 

Status Bar  Shows or hides the status bar. 

Bluetooth 
Device List   

 
Shows a list of registered Bluetooth devices. 

 

Window Menu Commands 

New Window  Opens the current file in a new window. 

Cascade  Arranges windows in an overlapped fashion. 

Tile  Arranges windows in nonoverlapped tiles. 

Arrange Icons  Arranges icons of minimized windows. 

Window 1, 2…  Goes to specified window. 

 

Help Menu Commands 

Help Topics 
 

Offers you an index to topics on which you can get help. 

About 
DigiTrak LWD 

 Displays the version number of the DigiTrak LWD software. 

 

Information Fields 

The LWD software displays information grouped in related fields as discussed briefly below. Detailed 
information on reading and editing the data fields are provided in the software’s help files. Use the tool tip 
helper or view help topics for more information.  

Site Information  

The site information section displays the job location and client information. Visible on the screen are: 

 Site Name and Location – Job name and physical location of site. 

 Client – Name of customer.  

 Phone – Contact phone number. 

All the address and contact information for the job, client, and contractor are listed on the printed report 
(see “Printing and Previewing Project Files” later in this section for more information regarding printed job 
files). 

There are three ways to open the Site Information dialog box where site information can be edited: select 
the Site Information command in the Edit menu; click on the site information icon on the toolbar; or 
double-click anywhere in the site information field of the application window. 
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Job Information 

The job information section displays statistical information about the job. This information includes: 

 Date – Date the job was started, which is retrieved from the first uploaded data point. For 
uploaded Eclipse jobs, the date is when the job was uploaded from the receiver. For imported 
Eclipse files, the date is when the file was imported into the LWD application.  

 Serial Number – ID or serial number of the receiver.  

 Job ID – Number assigned to the job in the receiver. 

 Data Points – Number of data points collected (includes manually inserted data).  

 Typical Rod Length – Typical length of the rods being used for the job. This length is taken from 
the Job Information dialog box, and it must be entered to enable the upload. 

 Depth – Measurement units being used for depth (feet, ft, or meters, m).   

 Pitch – Measurement units being used for pitch (percent, %, or degrees, °).  

 Pressure – Measurement units being used for pressure (pounds per square inch, psi, or kilo-
pascals, kPa).   

 Force – Measurement units being used for force (pounds-force, lbf, or kilonewtons, kN).   

 Elevation – Elevation of a survey marker near the bore (if used). 

 Entry – Entry position relative to the (0, 0) coordinates on the charts (positive or negative distance 
on the profile view chart and left, L, or right, R, position on the plan view chart). 

Most of the job information is included on the printed report, including the job ID, date, data points, and 
measurement units (see “Printing and Previewing Project Files” later in this section for more information 
regarding printed job files). The measurement units can be edited using the Display Units command in 

the Edit menu or by clicking on the display units icon  on the tool bar.  

There are three ways to open the Job Information dialog box, where you can edit the typical rod length, 
reference elevation, and relative position at entry: select the Job Information command in the Edit 

menu; click on the job information icon  on the toolbar; or double-click anywhere in the job information 

field of the application window. The Job Information dialog box also automatically launches after a new 
job is created. 

Data Point List 

The data point list is a table displaying all of the data points in the job. Within this table you can insert, 
edit, delete, hide, or remove individual data points. The columns included in the table depend on the type 
of DataLog file that is open. See “Drill Data File Features” and “Pressure-Tension File Features” later in 
this section for more information. 

Chart Area 

The chart area provides a graphical display of the data contained in the data point list. Data points that 
have been hidden or deleted will not display in the chart area. The type of data displayed in the chart area 
depends on the DataLog file type and the data recorded. Drill data files show a profile chart and, if an 
FPT is used, a pressure chart; pressure-tension files show a pressure chart and, if a TensiTrak 
transmitter is used, a force chart; and steering files (not dealt with in this manual) show profile and plan 
view charts.  
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The common features of chart areas are described below. See “Drill Data File Features” and “Pressure-
Tension File Features” later in this section for more information. 

 Data Points – Data points that have not been hidden or deleted display in the chart area. 

 Values – The X and Y axes of each graph shows the corresponding data value of the points 
contained in the chart area.  

 Cursor Coordinates – When the cursor is placed anywhere on the chart area, the value of the 
coordinates at that position display. If the cursor is placed on a data point, all data values 
recorded at that data point will display. 

 Zoom – To zoom into an area of the chart, hold down the control button on your computer then 
click and hold (control-click) on your mouse while you drag the pointer through the area you wish 
to explode. Release the mouse button once the area is selected. To return the chart to its normal 
scaling, control-click anywhere in the chart area. 

 

Editing and Annotating Charts 

The profile, pressure, and force charts can be edited and annotated in a number of ways. Shapes and 
captions can be drawn directly on the charts to describe job site conditions and other points of interest 
using the chart annotations commands under the Edit menu. Boundaries of the charts can be changed 
using the chart properties commands under the Edit menu. The help files in the LWD software provide 
full instructions on all editing capabilities. The instructions below are basic to getting started with the chart 
editing functions. 

Drawing Shapes and Adding Captions 

There are four ways to access the chart annotations dialog boxes, which allow you to draw shapes and 
enter information to be included on the chart and the printed report:  

 Select the desired chart annotations command (profile, pressure, or force) from the Edit menu.  

 Click on the desired chart annotations icon (profile, pressure, or force) on the tool bar.  

 Place the mouse on an existing annotation and double-click to change its properties. NOTE: 
Captions cannot be edited in this manner; only objects. 

 Hold the shift key down and use the mouse to draw a box around the area where you would like a 
shape to appear on the chart. The dialog box will open with the coordinates of the box you drew 
appearing in the Location area, as shown in the example below. 
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Locate (Profile) Chart Annotations Dialog Box 

Each chart annotations dialog box (locate/profile, pressure, and force) functions in the same way; only the 
coordinates shown in the Location and Caption sections of the dialog boxes will be different. If you open 
the chart annotations dialog box using an Edit menu command or a tool bar icon, you will need to enter 
the coordinates of the shape you wish to draw in the Location section of the dialog box. 

Selecting and Editing Shapes 

Using the pull-down menu in the Location section of the chart annotations dialog box, select the shape 
that you would like to add to the chart.   

Adjust the line weight and font size in the Line/Font section of the dialog box.  

Select which parts of the shape you would like to appear in the Draw Shape section of the dialog box.  

The color of the different parts of the shape can be adjusted by double-clicking on the ellipses in the Draw 
Shape section of the dialog box. 
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Adding and Editing Captions 

Before a caption can be entered, the check box next to Draw Caption in the Draw Shape section of the 
chart annotations dialog box must be checked to activate the Caption section of the dialog box. With the 
Caption section of the dialog box active, type the words you would like to appear on the graph in the text 
box in this section. You do not have to draw a shape to add a caption. 

If a shape is drawn, the caption will appear centered in the shape by default.  

To change the location or orientation of where the caption appears, click in the box next to Top - Left in 
the Caption section of the dialog box. Enter the coordinates of where you would like the text to begin.  

To change the orientation of the text, type the value of the slope of the text in the Text Slope text box. 

 

Editing Chart Properties 

There are two ways to open the chart properties dialog boxes (profile, pressure, and force) where you can 
edit properties such as chart boundaries and scaling:  

 Select the profile, pressure, or force chart properties command from the Edit menu.  

 Click on the desired chart properties icon (profile, pressure, or force) on the tool bar. 

Automatic scaling is selected by default. Click in the box next to Auto Scale so that you can change the 
horizontal or vertical scaling and chart boundaries. Then manually enter the desired coordinates for the 
chart boundaries. 

 

Drill Data File Features  

In addition to the features described above, drill data files contain information and controls specific to the 
pilot bore data. These features specific to drill data files are described in more detail below. 

Job Information 

The job information that is specific to drill data files includes the following: 

 Rod Length Information – Default, first, and last rod. 
 Survey Point Elevation Change (where applicable):  

 Reference Elevation – Known elevation. 

 Relative Elevation at Entry – Relative to ground (zero) or reference elevation (if used). 

 Relative Elevation at Exit – Relative to entry elevation or reference elevation (if used); this is 
the same as the survey point. 
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This information displays in the job information field of the application window and can be edited in the 
Drill DataLog Job Information dialog box shown below. 

 

Drill Data Job Information Dialog Box 

The unit for rod length and survey point elevation shown in the Job Information dialog box can be edited 

using the Display Units command in the Edit menu or by clicking on the display units icon  on the 

tool bar. This measurement is considered a distance and cannot be entered in feet/inches or inches. It 
can only be entered in decimal feet (ft) or meters (m). 

Rod Length Information  

Default Rod Length is the distance between data points, which must be constant. The rod length is 
typically the length of one drill rod. 

First Rod Length is the rod length for the first data point (rod 0), which is usually a partial rod. This value 
is determined by measuring the amount of drill rod left in the rack from the make-up/break-out clamps to 
the top of the rod when rod 0 is recorded. 

Last Rod Length is the rod length for the last data point, which is usually a partial rod. This value is 
determined by measuring the length of the drill rod left on the rack from the make-up/break-out clamps to 
the top of the rod and then subtracting this distance from the rod length. For example, if the length of rod 
left on the rack is 6 ft (1.8 m), and your rod length is 10 ft (3.0 m), the last rod will measure 4 ft (10 ft – 6 ft 
= 4 ft) or 1.2 m (3.0 m – 1.8 m = 1.2 m). 

For F5 receiver uploads, rod length data is included in the upload. The rod length data can be changed in 
the Job Information dialog box if it was entered incorrectly on the receiver. 

For Eclipse receiver uploads, you can set the default rod lengths by clicking the Set Defaults button. The 
current settings will then be saved and used for all new Eclipse uploads. Note that you can change the 
settings for any single file without changing the default settings. The new settings will stay with that file 
when the file is saved. 

Same as 

survey point 
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Survey Point Elevation Change  

Reference Elevation is the elevation of a reference geographical survey point near the bore. If a 
reference elevation is not required, check the box labeled “Do Not Use Reference Elevation.” This will 
disable the Reference Elevation at Entry field and the terrain surface at the tool's point of entry will be the 
zero elevation reference on the chart and the data point list. When a reference elevation is used, its value 
becomes the zero reference on the chart and the data point list. 

Relative Elevation at Entry is the vertical distance from the zero elevation reference line to the point 
where the bore penetrates the ground. In most cases, the point of entry is at the terrain surface. When a 
trench is used, this point is at the bottom of the trench.  

NOTE: If the entry is in a trench, then you need to include the depth of the trench in the value 
for the Rel. Elev. At Entry. Rod 0 must be edited to show the depth of the trench below 
the reference elevation. If a reference elevation is not used, then rod 0 must be edited to 
show the depth of the trench as the Rel. Elev. At Entry. 

Relative Elevation at Exit is the vertical distance from the terrain at rod 0 to the terrain at the last rod or 
survey point entered in the F5 receiver. This presumes the depth at rod 0 is entered as required, as 
discussed above, to correct the calculation of the tool path. 

If a relative elevation at exit is not required, check the box labeled “Do Not Use Exit Survey Point.” The 
exit point will then be calculated based on the pitch, rod, and depth data only. 

 

Data Point List 

The data point list is a table that displays all the data points in the job in the order they were recorded and 
their associated data. Within the table you can edit, delete, hide, or remove individual data points. The 
columns in the table include: 

 Rod ID – Rod number and status of the data point. A colored flag is displayed to indicate the 
status of the data:  

 Red Flag: Pitch missing; the pitch must be entered for the tool path to be calculated correctly.  

 Magenta Flag: Depth missing; highlights pitch-only data points for the operator. NOTE: 
Opening the Edit Data Point dialog box and clicking on OK will restore this flag to either blue 
or olive green depending on the data entered by the operator for depth.  

 Blue Flag: Data point has been edited.  

 Gray Flag: Data has been hidden or removed.  

 Olive Green Flag: Overwritten data.  

 Black Flag: Original data.  
 Rod Len. – Length of the rod. 
 Bore Len. – Length of the bore (sum of all the previous rod lengths plus the current rod length). 
 X Dist. – Horizontal distance from the entry point. 
 Pitch – Pitch value recorded at the specified data point. Units are those displayed in the job 

information field (% or °).  
 Rel. Depth – Relative depth calculated by integrating rod length and pitch data starting at the 

relative elevation at the entry point. 
 Depth – The overhead distance from the tool to the terrain surface. This can be measured, 

entered manually by the user, or interpolated by the LWD software based on inserted or missing 
data. 
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 Rel. Elev. – The terrain surface elevation calculated by combining the relative depth and the 
measured depth. 

 Date/Time – This column displays the date and time the specified data point was recorded. 
 Type – Information regarding the type of data recorded at the data point: 

 BL: Blank (no pitch or depth data recorded with data point)  

 PO: Pitch Only  

 LL: Locate Line  

 FLP: Front Locate Point  

 IN: Inserted data point. NOTE: Pitch and depth defaults are interpolated from adjacent data 
and not displayed by default. This data can be modified if required by overwriting the default 
values listed. The new data point is listed alphabetically (i.e., the first point manually inserted 
after rod number 2 is listed as 2-A, the second as 2-B, etc.).  

 RawDepth – The projected depth displayed on the receiver. 
 RawDist – The horizontal distance from the FLP or the LL to the overhead line. 
 Comment – Any comments on individual data points can be added to show in this column (see 

“Edit Rod/Data Point” below).  

Specific symbols are used in the data point list to identify types of data, as described below: 

 The “o” symbol indicates that the data is overwritten manually.  
 The “e” symbol indicates that the rod length is edited. 
 The “i” symbol indicates that the data is interpolated.  
 The “f” symbol indicates that the data is filled in; the data was missing in the original upload.  
 The “h” symbol indicates that the data is hidden.  
 The “x” symbol indicates that the pitch data is missing.  

 
Instructions for editing data points are provided below. The main menus for editing information in the data 
point list are accessed by right-clicking on a data point to open a pop-up menu with the following menu 
options: Edit, Insert, Delete, Hide, and Remove. 

Insert Rod/Data Point 

1. Select the data point prior to where the new data point is to be inserted.  

2. Right-click to open the pop-up menu, and select Insert.  

3. A new data point will appear in the data list and on the chart. The new data point will be numbered 
the same as the one prior to it with a letter appended (for example, the first point manually inserted 
after rod 2 will be listed as 2-A, the second as 2-B, etc.). The values listed for pitch and depth are 
interpolated from adjacent data, and depth is hidden by default. This data can be modified by editing 
the data point and overwriting the value listed (see “Edit Rod/Data Point” below). The rod type will be 
listed as IN for inserted data. 

4. To restore original sample data, if necessary, right-click on the data point and select Edit to open the 
Edit Data Point dialog box, then click the Restore Default button next to the data to be restored.  

5. Click OK to save changes, or Cancel to close without saving.  

Edit Rod/Data Point 

1. Select the data point to be edited.  

2. Open the Edit Data Point dialog box by either right-clicking to open the pop-up menu, and selecting 
Edit, OR double-clicking the data point in the list or on the chart.  
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Edit Data Point Dialog Box 

3. Modify the data as required: 

 Pitch is Missing/Unknown check box – If a blank data point is recorded, this box is enabled and 
checked by default. You should enter the correct pitch value and uncheck the box. When the 
check box is enabled and checked, there will be a gap in the data line on the chart. The missing 
data point will be emphasized on the chart.  

 Depth is Hidden/Unknown check box – If a new rod is inserted or a blank or pitch-only data point 
is recorded, this box is checked by default. You can enter the overhead depth value and uncheck 
the box. When the box is checked, there will be a gap in the data on the chart and the missing 
point will not be shown. Uncheck box to display missing data. 

 To restore original recorded data, if necessary, click the Restore Default button next to the data to 
be restored.  

4. Add a comment (optional).  

5. Click OK to save changes, or Cancel to close without saving.  

Delete Inserted Rod/Data Point 

1. Select the data point to be deleted.  

2. Right-click to open the pop-up menu, and select Delete.  

3. The data point will be removed from the data point list and from the chart.  

Rod length in same 
units as depth 

measurement 

Box is automatically 
checked if blank or 
pitch-only rod is 
inserted  

Box is automatically 
checked if blank rod 

is inserted  
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NOTE: You cannot delete original data. If a rod is unintentionally recorded twice, you should 
select Remove to delete that data point from the chart and calculations. Eclipse data is 
imported and considered original data. It cannot be deleted. 

Hide 

When this option is selected, the data point still appears in the data list but it is hidden on the chart. The 
data is still included in the calculations. A checkmark is placed next to the option on the pop-up menu.  

Remove 

When this option is selected, the data point is removed from the list, the chart, and the calculations. This 
option can be used, for example, on original data that was unintentionally recorded twice. 

 

Profile Chart 

The profile chart is a visual representation of uploaded data. This includes the terrain surface, all data 
point information, and the tool path. The profile chart below shows annotations such as utility flags and 
shape objects that were added after the upload. 

 

Drill Data Profile Chart 

Data Points 

Data points on the profile chart display as blue dots. Hovering the mouse pointer over a data point will 
display all the data recorded at that point. Clicking on the chart will advance the data point list to display 
the data point associated with the chart location.  

Double-clicking on a data point will open the Edit Data Point dialog box to allow you to edit the data for a 
data point, as discussed above. Highlighted data points (points with gray circle behind them) indicate a 
rod has been inserted or the pitch has been edited. The green terrain points can also be edited, but only 
for depth, and will be highlighted if they have been edited. 

It is possible to hide data points on the chart; however, they will still display in the data points list. This is 
used in cases where the data point conflicts with a utility flag, for example—the data point can be hidden 
to allow the flag to display properly. 
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Utility Flags 

Utilities flags are used to show the location and type of utility on the chart area and printed report. They 
can be added, edited, or removed in the Utility Flags dialog box. There are four ways to open the Utility 
Flags dialog box:  

 Select the Utility Flags option from the Edit menu. 

 Click on the utility flags tool bar icon .  

 Hold down the shift key on the keyboard and click the mouse (shift-click) on a specific point on 
the chart to open the Utility Flags dialog box with the location of a new flag specified at that point.  

 Double-click on an existing utility flag.  

 

Utility Flags Dialog Box 

Distance is the horizontal length on the surface of the ground from the entry point to the utility. The 
measurements units can be changed using the Display Units menu under the Edit menu. NOTE: 
Distance will only be displayed as decimal feet (ft) or meters (m). 

Depth is the vertical length from the surface to the utility. 

Type is selectable from the pull-down list. The flag will appear on the chart as a circle using the APWA 
(American Public Works Association) recommended colors. The type of utility is listed as the default 
caption. If a comment is added, the comment will be displayed as the caption instead of the utility type.  

Text Slope is the angle of the caption text on the chart. 

Comment is used to enter a custom caption for a utility flag. 

NOTE: Utility Flags should not be confused with Data Flags in pressure-tension files, which are 
added by the receiver operator as data is recorded. 
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Pressure Chart 

A pressure chart will appear on the drill data file only if the transmitter supports pressure data. The 
pressure chart provides a visual representation of uploaded data and annotations added after data was 
uploaded. If you hover the mouse over a data point on the chart, data point details will appear for that 
specific point. Gaps in the data points indicate missing data. 

 

Drill Data Statistical Pressure Chart 

The colors and types of data points are as follows:  

 Green Data Points – Indicate the average pressure recorded during that rod and any rods 
recorded and deleted before that rod was recorded. 

 Blue Data Points – Indicate the high pressure recorded during that rod and any rods recorded 
and deleted before that rod was recorded. The high pressure is the average plus 1 standard 
deviation—this includes 84% of the pressure readings (assuming a normal distribution). 
Statistically, there will have been occasional spikes above this pressure. 

 Gold Data Points – Represent the maximum pressure recorded during the rod and any rods 
recorded and deleted before that rod was recorded. 

 Highlighted Data Points – Highlighted data points (points with a green circle behind them) indicate 
that rods have been deleted during the data collection process. 

NOTE: Pressure data cannot be deleted. If an overpressure event was recorded during a rod that was 
subsequently deleted, it will be accumulated into the data of the next recorded rod. To attempt to identify 
the location of the overpressure event will require having RECORDED the pressure log and uploading it 
as a pressure-tension file. That file will contain flags marking all recorded and deleted rods.  

To view the mud pressure data as a continuous graph of the data as it was recorded every 4 seconds, 
you can upload the recorded pressure-tension DataLog file into a pressure-tension file. See “Pressure-
Tension File Features” below for more information. 
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Pressure-Tension File Features 

In addition to the features described in the beginning of this section, pressure-tension files contain 
information and controls specific to the continuous data logs of mud pressure (when a pressure-sensing 
transmitter is used) and pull force (when a TensiTrak transmitter is used). The features specific to the 
information fields and editing controls in the pressure-tension file are described in more detail in the 
following sections. 

Job Information 

Job information to be included on the printed report, such as pressure or tension limit thresholds allowed 
for the job, product type installed for a TensiTrak job, and direction of graphed data, can be added and 
edited using the Pressure-Tension Job Information dialog box described below. There are three ways to 
access the Job Information dialog box: 

 Select the Job Information option from the Edit menu. 

 Click on the job information tool bar icon .  

 Double-click in the job information field.  

 

Pressure-Tension Job Information Dialog Box 

Design Limit Thresholds 

Allows you to enter limits for acceptable pressure and/or tension (pull force) values recorded during the 
bore and/or product installation. The design limit thresholds displays on the printed report. 

Use Tension Design Limit must be checked to enter a value for the maximum pull-force allowed for the 
project. The units that display (lbf or kN) depend on the units set in the Display Units dialog box. 

Use Pressure Design Limit must be checked to enter a value for the maximum mud pressure allowed 
for the project. The units that display (psi or kPa) depend on the units set in the Display Units dialog box. 
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If a design limit threshold is set, data points in the data point list and chart area will be yellow or red as the 
design threshold limit is approached or exceeded.  

Product Information 

Material being installed for a TensiTrak job may be entered in this text box. You may type any notable 
details about the material installed to be included on the printed report.  

Length is the total length of product that was installed during the pullback. The units that display (ft or m) 
depend on the units set in the Display Units dialog box. 

Diam is the diameter of the product installed. The units that display (in or mm) depend on the units set in 
the Display Units dialog box. 

Right to Left or Left to Right refers to the direction the data displays on the graph area. The data should 
be displayed relative to the direction of the pilot bore profile chart for accurate comparison. Select Right 
to Left when product is pulled in from the pilot bore exit. Select Left to Right when the pressure and/or 
tension data is recorded starting from the entry point of a pilot bore. 

Data Point List 

The data points list is a table displaying all of the data points in the job and the associated data. The 
columns in the table include: 

 Data Point – This column displays the number and status of the data point.  
 Force – This column displays the force value recorded by the receiver at the specified data point. 

Units are those displayed in the job information field. An “x” indicates no data.  
 Max F. – This column displays the maximum force value recorded by the receiver at all data 

points up to the one indicated. Units are those displayed in the job information field. An “x” 
indicates no data. 

 Pres. – This column displays the pressure value recorded by the receiver at the specified data 
point. Units are those displayed in the job information field. An “x” indicates no data. 

 Max P. – This column displays the maximum pressure collected during the job up to the time 
when the data point was recorded. 

 Data Flag – If a flag was recorded on the F5 receiver at a specified data point, the flag number 
would be noted in this column. 

 Date/Time – This column displays the date and time the specified data point was recorded. This 
information does not show on the charts or printed report. 

Removing Data Points 

To remove data points, click the mouse near the location on the graph where you want to remove data 
points. The data points list will adjust to show the group of data points near the location where you 
clicked. Click on the first data point you would like to remove from the list and hold the shift key down. 
Then click on the last data point you would like to remove from the list. Right-click in the data points list 
and select the Remove option. The data points you selected will no longer show on the charts. The data 
points list will indicate the points have been removed from the chart.  
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Pressure Chart  

The pressure chart shows the downhole mud pressure (in psi or kPa) at each data point. If a pressure 
limit threshold was set, data points will be magenta or red as the pressure threshold is approached or 
exceeded. In the case below, the pressure limit threshold was set to 150 psi.  

 

Mud Pressure Chart 

Data Points 

 Blue Data Points – Indicate normal data points. 

 Red Data Points – Indicate the point exceeded the maximum design pressure or force limits. 

 Magenta Data Points – Indicate the point is within 5% of the entered design pressure or force 
limits. Design limits can be entered or edited in the Pressure-Tension DataLog Job Information 
dialog box. 

 Orange Data Lines – Identify the maximum pressure (force) recorded up to that data point. 

NOTE: Data points within 15% of the maximum or high pressure are automatically selected for printing. 
You can change this selection in the data points list by either right clicking on an individual data point or 
on a selected range of data points and selecting Print or Don't Print from the pop-up menu. To select a 
range of data points, shift-left-click (hold down the shift key and click the left mouse button) on the first 
data point to be selected, and then shift-left-click on the data point at the bottom of the range. To select 
multiple data points that are not in a contiguous range, ctrl-left-click on each data point to be selected. 

It is possible to remove data points on the charts; however, they will still display in the data points list and 
will be marked “-X” in the data point list. This can be used in cases where data was being collected while 
the machine was idle, for example. The data can be included again on the chart at any time. 

Data Flags 

Highlighted data points (points with a green circle behind them) have had a data flag added by the 
receiver operator. The color, label, and location of data flags can be edited in the Pressure-Tension Data 
Flags dialog box. There are four ways to open the Pressure-Tension Data Flags dialog box: 

 Select the Data Flags option from the Edit menu. 

 Click on the data flags tool bar icon .  

 Right-click on a data point in the data point list and select Add Data Flag to open the Pressure-
Tension Data Flags dialog box with the location filled in for the point selected.  

 Double-click on an existing data flag.  
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Pressure-Tension Data Flags Dialog Box 

When a fluid pressure transmitter is used during a pilot bore and the drill data file is recorded as well, as 
in the case shown in the mud pressure chart above, a data flag will be recorded every time a new rod is 
added or a rod is deleted. The flag will be labeled “NewRod” in the case of a new data point being 
recorded in the drill data file. If a rod is deleted from the drill data file by the receiver operator, the flag will 
be labeled “DelRod” on the pressure chart. You can choose to hide or display the data flags for new and 
deleted rods on the pressure chart. 

Data flags that are manually added by the receiver operator, whether during a pilot bore or pullback, will 
be identified on the chart with the flag number that displayed when it was recorded, as shown on the pull 
force chart below. The data flag label, color, and location can be edited in the Pressure-Tension Data 
Flags dialog box.  

Data flags that are added after upload are called user flags. After upload, you can add user flags with 
comments and you can add comments to flags recorded during data collection. Only user flags that have 
been added manually after upload can be deleted. Flags recorded by the operator during data collection 
cannot be deleted.  

NOTE: Data flags should not be confused with utility flags. Utility flags do not apply to a pressure-
tension file. 

To edit existing data flags or to remove user flags in the file, use the features in the Pressure-Tension 
Data Flags dialog box as follows: 

 Raw DP Index – Represents the data point number in the list of all data points. This cannot be 
edited.  

 Show At Pressure – Indicates the pressure at which the data flag will display. If the check box is 
unchecked, the flag is not displayed on the chart.  

Location data 
point will 

appear on chart  

Checked box 
indicates 
respective flag 
will not display 
on chart 
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 Show At Force – Indicates the force at which the data flag will display. If the check box is 
unchecked, the flag is not displayed on the chart.  

 Draw Flag – Double-click the color oval in the Draw Flag box to edit the color. 

After making any changes, click the Change button to save the changes to the file. Then click OK to exit 
the dialog box. 

NOTE: If you just click OK, then you are simply closing the dialog box and not saving the changes. 
You must click the Change button or your changes will not be saved. 

The edited flag will appear on the chart as a circle using the color chosen under the Draw Flag section.  

The number/type of the data flag is listed as the default caption. If a comment is added, the comment will 
be displayed as the caption instead of the data flag number. The caption angle on the chart can be 
changed by editing the Text Slope. 

By default, the data flag is displayed at the pressure (force) that was measured when the flag was 
recorded or added. The “Show At” check boxes allow you to move the flag to a different level in the chart. 
This allows the marker to be displayed away from the measured data, if desired. 

Force Chart  

The pull force chart only displays for TensiTrak jobs. It shows the product pull force measured (in lbf or 
kN) at each data point. If a force limit threshold was set, data points will be yellow or red as the force 
threshold is approached or exceeded. In the case below, the force limit threshold was set to 40,000 lbf.  

 

Pull Force Chart 

Data points and data flags that appear on the force chart can be manipulated using the same methods as 
for the pressure chart. See the DigiTrak F5 TensiTrak Operator’s Manual for complete instructions on 
using the LWD software with the F5 TensiTrak system. 

 

Printing and Previewing Project Files 

To preview the printed pages before you send the file to print, select Print Preview from the File menu or 
click on the print preview icon on the tool bar. To close the print preview window and return to the file, 
click on the Close button in the print preview window. To print the file from the print preview window, click 
on the Print button. 
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To edit printing properties such as the printer or paper size and orientation, select Print Setup from the 
File menu or click on the print setup icon on the tool bar. 

There are three ways to print the job data: select Print from the File menu, click on the print icon on the 
toolbar, or click on the Print button in the print preview window. After selecting a print option, the Print 
dialog box will appear. Make any adjustments needed in the Print dialog box, then click on OK. If you 
have the Adobe Acrobat PDF writer software, you can select the Adobe PDF printer to print to a PDF file 
(see your Adobe software documentation).  

The job data will print on at least three pages. The job information, including location, client, and 
contractor information, if entered, will appear on the first page, along with the statistical data about the job 
and any job comments. The profile and plan view charts will appear on the second page. The third page 
(and more if needed) will list the drill data. Data for data points that have been removed will not display. 
The topography survey data and drill data, if entered, will display. 

 

Saving Project Files  

To save an open project file, select Save from the File menu or click on the save icon on the toolbar. If 
the file has already been named and saved, it will automatically be saved under its current file name and 
location. If the project has not yet been named and saved, then the Save As dialog box will open where 
you can enter the file name and select the save location. The default file name for drill data files is 
DrillData#.dl5, and for pressure-tension files it is Pressure-Tension#.dl5. In both cases, “#” represents a 
number that starts at 1 and advances automatically as files are saved. 

To save an open file with a different file name or location, select Save As from the File menu. The Save 
As dialog box will appear, which automatically opens to the folder where the current file is saved. Change 
the file name and location as desired, then click the Save button. The open file will now have the new file 
name and/or location.  

DCI recommends saving each job file with two different names in the event that one file becomes 
corrupted.  

 

E-mailing Report to Customer Who Does  
Not Have DigiTrak LWD Software 

The DigiTrak LWD software is able to generate a printed report or an electronic copy of your file, as 
discussed above under “Printing and Previewing Project Files.” In addition, electronic project files can be 
sent to and opened by anyone who has the DigiTrak LWD software. 

If you want to send an electronic copy to a customer who does not have the LWD software, we suggest 
you use a document-generating printer driver to create a PDF file using any of the following: 

 PrimoPDF – This free software is available for download online at www.primopdf.com. With this 
software installed, you can print the report to PrimoPDF instead of your printer and save the 
report as a PDF file. This file can then be attached to an e-mail message. Please refer to 
PrimoPDF for instructions in the use of this product.  

 Bullzip PDF Printer – This free software is available for download online at www.bullzip.com. With 
this software installed, you can print the report to Bullzip PDF Printer and save the report as a 
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PDF file. This file can then be attached to an e-mail message. Please refer to Bullzip for 
instructions in the use of this product.  

 Microsoft XPS Printer – Microsoft has generated a nonstandard encapsulated postscript format 
called *.xps. It is a standard Windows component and will probably appear in your printer list. 
Only Microsoft Internet Explorer can present this document type without a translator. If IE is not 
your default web browser, then you or your customer may not be able to view this file type. 
Please refer to http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-
Document-Writer for instructions on use with your specific operating system.  

Additional information can be found at the website: help.digitrak.com  

Once you have a document writer installed: 

1. From the File menu or the toolbar, select the Print option to open the Print dialog box. 
2. Under Printer at the top, use the pull-down menu to select your PDF writer or Microsoft XPS 

Document Writer. 
3. Click on the Properties button to open the Properties dialog box, and then select portrait or landscape 

orientation (landscape is recommended).  
4. Click on OK to save the orientation and close the Properties dialog box.  
5. Click on OK to save the file as a *.pdf or *.xps file type. The Save As dialog box will appear. 
6. Input the name for your file in the file name text box.  
7. Choose the location/folder where you want to save the file.  
8. Click on the Save button to save the file.  
9. Attach the saved PDF or XPS file to your e-mail message. The customer can view the file in a PDF 

compatible viewer such as Adobe Acrobat or a Microsoft XPS compatible viewer such as Internet 
Explorer.  

As an alternative to e-mailing a PDF or XPS file, the printed document can be scanned and attached to 
an e-mail message. 
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LIMITED WARRANTY 

Digital Control Incorporated ("DCI") warrants that when shipped from DCI each DCI Product will conform to DCI’s current published 
specifications in existence at the time of shipment and will be free, for the warranty period (“Warranty Period”) described below, from 
defects in materials and workmanship. The limited warranty described herein (“Limited Warranty”) is not transferable, shall extend only to 
the first end-user (“User”) purchasing the DCI Product from either DCI or a dealer expressly authorized by DCI to sell DCI Products 
(“Authorized DCI Dealer”), and is subject to the following terms, conditions and limitations: 

1. A Warranty Period of twelve (12) months shall apply to the following new DCI Products: receivers/locators, remote displays, battery 
chargers and rechargeable batteries, and DataLog

®
 modules and interfaces. A Warranty Period of ninety (90) days shall apply to all 

other new DCI Products, including transmitters, accessories, and software programs and modules. Unless otherwise stated by DCI, 
a Warranty Period of ninety (90) days shall apply to: (a) a used DCI Product sold either by DCI or by an Authorized DCI Dealer who 
has been expressly authorized by DCI to sell such used DCI Product; and (b) services provided by DCI, including testing, servicing, 
and repairing an out-of-warranty DCI Product. The Warranty Period shall begin from the later of: (i) the date of shipment of the DCI 
Product from DCI, or (ii) the date of shipment (or other delivery) of the DCI Product from an Authorized DCI Dealer to User. 

2. DCI’s sole obligation under this Limited Warranty shall be limited to either repairing, replacing, or adjusting, at DCI’s option, a 
covered DCI Product that has been determined by DCI, after reasonable inspection, to be defective during the foregoing Warranty 
Period. All warranty inspections, repairs and adjustments must be performed either by DCI or by a warranty claim service authorized 
in writing by DCI. All warranty claims must include proof of purchase, including proof of purchase date, identifying the DCI Product 
by serial number. 

3. The Limited Warranty shall only be effective if: (i) within fourteen (14) days of receipt of the DCI Product, User mails a fully 
completed Product Registration Card to DCI; (ii) User makes a reasonable inspection upon first receipt of the DCI Product and 
immediately notifies DCI of any apparent defect; and (iii) User complies with all of the Warranty Claim Procedures described below. 

WHAT IS NOT COVERED 

This Limited Warranty excludes all damage, including damage to any DCI Product, due to: failure to follow DCI’s operator’s manual and 
other DCI instructions; abuse; misuse; neglect; accident; fire; flood; Acts of God; improper applications; connection to incorrect line 
voltages and improper power sources; use of incorrect fuses; overheating; contact with high voltages or injurious substances; use of 
batteries or other products or components not manufactured or supplied by DCI; or other events beyond the control of DCI. This Limited 
Warranty does not apply to any equipment not manufactured or supplied by DCI nor, if applicable, to any damage or loss resulting from 
use of any DCI Product outside the designated country of use. By accepting a DCI Product and not returning it for a refund within thirty 
(30) days of purchase, User agrees to the terms of this Limited Warranty, including without limitation the Limitation of Remedies and 
Liability described below, and agrees to carefully evaluate the suitability of the DCI Product for User’s intended use and to thoroughly read 
and strictly follow all instructions supplied by DCI (including any updated DCI Product information which may be obtained at the above DCI 
website). In no event shall this Limited Warranty cover any damage arising during shipment of the DCI Product to or from DCI. 

User agrees that the following will render the above Limited Warranty void: (i) alteration, removal or tampering with any serial number, 
identification, instructional, or sealing labels on the DCI Product, or (ii) any unauthorized disassembly, repair or modification of the DCI 
Product. In no event shall DCI be responsible for the cost of or any damage resulting from any changes, modifications, or repairs to the 
DCI Product not expressly authorized in writing by DCI, and DCI shall not be responsible for the loss of or damage to the DCI Product or 
any other equipment while in the possession of any service agency not authorized by DCI. 

DCI reserves the right to make changes in design and improvements upon DCI Products from time to time, and User understands that DCI 
shall have no obligation to upgrade any previously manufactured DCI Product to include any such changes. 

THE FOREGOING LIMITED WARRANTY IS DCI’S SOLE WARRANTY AND IS MADE IN PLACE OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE, IMPLIED WARRANTY OF NON-INFRINGEMENT, AND ANY IMPLIED WARRANTY ARISING FROM 
COURSE OF PERFORMANCE, COURSE OF DEALING, OR USAGE OF TRADE, ALL OF WHICH ARE HEREBY DISCLAIMED AND 
EXCLUDED. If DCI has substantially complied with the warranty claim procedures described below, such procedures shall constitute 
User’s sole and exclusive remedy for breach of the Limited Warranty. 

http://www.digitrak.com/
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LIMITATION OF REMEDIES AND LIABILITY 

In no event shall DCI or anyone else involved in the creation, production, or delivery of the DCI Product be liable for any 
damages arising out of the use or inability to use the DCI Product, including but not limited to indirect, special, incidental, or 
consequential damages, or for any cover, loss of information, profit, revenue or use, based upon any claim by User for breach of 
warranty, breach of contract, negligence, strict liability, or any other legal theory, even if DCI has been advised of the possibility 
of such damages. In no event shall DCI’s liability exceed the amount User has paid for the DCI Product. To the extent that any 
applicable law does not allow the exclusion or limitation of incidental, consequential or similar damages, the foregoing 
limitations regarding such damages shall not apply. 

This Limited Warranty gives you specific legal rights, and you may also have other rights which vary from state to state. This Limited 
Warranty shall be governed by the laws of the State of Washington. 

WARRANTY CLAIM PROCEDURES 

1. If you are having problems with your DCI Product, you must first contact the Authorized DCI Dealer where it was purchased. If you 
are unable to resolve the problem through your Authorized DCI Dealer, contact DCI’s Customer Service Department in Kent, 
Washington, USA at the above telephone number between 6:00 a.m. and 6:00 p.m. Pacific Time and ask to speak with a customer 
service representative. (The above “800” number is available for use only in the USA and Canada.) Prior to returning any DCI 
Product to DCI for service, you must obtain a Return Merchandise Authorization (RMA) number. Failure to obtain an RMA may 
result in delays or return to you of the DCI Product without repair. 

2. After contacting a DCI customer service representative by telephone, the representative will attempt to assist you in troubleshooting 
while you are using the DCI Product during actual field operations. Please have all related equipment available together with a list of 
all DCI Product serial numbers. It is important that field troubleshooting be conducted because many problems do not result from a 
defective DCI Product, but instead are due to either operational errors or adverse conditions occurring in the User’s drilling 
environment. 

3. If a DCI Product problem is confirmed as a result of field troubleshooting discussions with a DCI customer service representative, 
the representative will issue an RMA number authorizing the return of the DCI Product and will provide shipping directions. You will 
be responsible for all shipping costs, including any insurance. If, after receiving the DCI Product and performing diagnostic testing, 
DCI determines the problem is covered by the Limited Warranty, required repairs and/or adjustments will be made, and a properly 
functioning DCI Product will be promptly shipped to you. If the problem is not covered by the Limited Warranty, you will be informed 
of the reason and be provided an estimate of repair costs. If you authorize DCI to service or repair the DCI Product, the work will be 
promptly performed and the DCI Product will be shipped to you. You will be billed for any costs for testing, repairs and adjustments 
not covered by the Limited Warranty and for shipping costs. In most cases, repairs are accomplished within 1 to 2 weeks. 

4. DCI has a limited supply of loaner equipment available. If loaner equipment is required by you and is available, DCI will attempt to 
ship loaner equipment to you by overnight delivery for your use while your equipment is being serviced by DCI. DCI will make 
reasonable efforts to minimize your downtime on warranty claims, limited by circumstances not within DCI’s control. If DCI provides 
you loaner equipment, your equipment must be received by DCI no later than the second business day after your receipt of loaner 
equipment. You must return the loaner equipment by overnight delivery for receipt by DCI no later than the second business day 
after your receipt of the repaired DCI Product. Any failure to meet these deadlines will result in a rental charge for use of the loaner 
equipment for each extra day the return of the loaner equipment to DCI is delayed. 


